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Working with Linksets

SGM enables you to view information about all discovered linksets, including 
their associated nodes, status, and other important information.

This section includes the following information:

• Viewing Basic Information for Linksets, page 8-2

• Viewing Detailed Information for a Linkset, page 8-11

• Viewing Real-Time Data for a Linkset, page 8-28

• Attaching a Note to a Linkset, page 8-53

• Viewing Notes for a Linkset, page 8-54

• Deleting a Linkset, page 8-54

• Ignoring a Linkset, page 8-56

• Viewing Ignored Linksets, page 8-57

• Viewing Linkset Information Using a Web Browser, page 8-57

Related Topics:

• Changing SGM Client Preference Settings, page 23-2

• Resizing, Sorting, and Hiding Table Columns, page 3-53

• Working with Links, page 9-1
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Chapter 8      Working with Linksets
    Viewing Basic Information for Linksets
Viewing Basic Information for Linksets
SGM enables you to view basic information about all discovered linksets, 
including their associated nodes, status, and other important information.

To view basic information for linksets, select Linksets in the left pane of the SGM 
Main Window. SGM displays the Linkset Window.

The Linkset Window displays information about the linksets that have been 
discovered by SGM.

The Linkset Window is composed of the following sections:

• Right-Click Menu for All Linksets, page 8-3

• Right-Click Menu for a Specific Linkset, page 8-3

• Linkset Table, page 8-7

Related Topics:

• Attaching a Note to a Linkset, page 8-53

• Changing SGM Client Preference Settings, page 23-2

• Resizing, Sorting, and Hiding Table Columns, page 3-53

• Using the SGM Main Menu, page 3-9

• Working with Linksets, page 8-1

• Viewing Detailed Information for a Linkset, page 8-11

• Viewing Notes for a Linkset, page 8-54
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Right-Click Menu for All Linksets
To see the right-click menu for all linksets, select Linksets in the left pane and 
click the right mouse button. The linksets right-click menu provides the following 
options:

Right-Click Menu for a Specific Linkset
The Linkset Window provides a subset of the SGM Main Menu as a right-click 
menu. To see this menu, select a linkset and click the right mouse button. The 
linkset right-click menu provides the following options:

Menu Command Description

Show In New Window Opens the Linkset Window in a new window.

Sort Tree By Status Sorts the entire tree in the left pane by the status of each object.

Sort Tree By Name Sorts the entire tree in the left pane by the name of each object.

Back > List of Windows Navigates back to a window viewed in this session.

SGM maintains a list of up to 10 Back windows.

Forward > List of Windows Navigates forward to a window viewed in this session.

SGM maintains a list of up to 10 Forward windows.

Menu Command Description

Edit Notes Opens the Edit Notes Dialog for the selected linkset.

If you have implemented SGM User-Based Access, this 
option is available to users with authentication level Power 
User (Level 2) and higher.

Clear Event Icon Deletes the event icon (orange triangle) from SGM 
displays for the selected linkset, for this SGM client only. 
The actual events are not deleted from SGM, only the event 
icon for the selected linkset for this SGM client.

This option is grayed-out if the selected linkset has no 
associated event icon.
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Delete Deletes the currently selected linkset from the SGM 
database. SGM displays the Confirm Deletion dialog:

• To delete the selected linkset, click Yes. The linkset is 
deleted from the SGM database and the Confirm 
Deletion dialog is closed.

• To retain the selected linkset, click No. The linkset is 
kept in the SGM database and the Confirm Deletion 
dialog is closed.

Note If you delete all linksets to an Unmanaged node, 
SGM does not automatically delete the node. 
Instead, you must manually delete the node. See the 
“Deleting a Node” section on page 6-100 for more 
information.

• To prevent SGM from displaying the Confirm Deletion 
dialog, select the Do not show this again checkbox.

Note If you select the Do not show this again checkbox, 
and you later decide you want SGM to begin 
displaying the Confirm Deletion dialog again, you 
must select the Confirm Deletions checkbox in the 
General GUI settings in the Preferences window. 
For more information, see the description of the 
Confirm Deletions checkbox in the “Startup/Exit 
Settings” section on page 23-6.

If you have implemented SGM User-Based Access, this 
option is available to users with authentication level 
Network Administrator (Level 4) and higher.

Go To > SP Displays the Signaling Point Window for the signaling 
point associated with this linkset.

SGM displays two Go To > SP links if both sides are in the 
model.

Menu Command Description
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Go To > Node Displays the Node Window for the node associated with 
this linkset.

SGM displays two Go To > Node links if both sides are in 
the model.

Back > List of Windows Navigates back to a window viewed in this session.

SGM maintains a list of up to 10 Back windows.

Forward > List of Windows Navigates forward to a window viewed in this session.

SGM maintains a list of up to 10 Forward windows.

View > Components Displays the Components panel for the selected linkset.

View > Configuration Details Displays the Configuration Data panel for the selected 
linkset.

View > Notes Displays the Notes panel for the selected linkset.

If there are no notes associated with the selected linkset, 
this option is grayed-out.

View > Events Displays the Recent Events panel for the selected linkset 
and its associated links.

View > Real-Time Data and Charts Displays the Statistics Details Window for the selected 
linkset.

If you have implemented SGM User-Based Access, this 
option is available to users with authentication level Power 
User (Level 2) and higher.

This option is not available if the linkset is in Unknown or 
Unavailable status, or if the linkset is a Virtual linkset.

View > Center in Topo Opens the Topology Window, with the display zoomed to 
center on the selected linkset.

If more than one view contains the selected linkset, SGM 
prompts you to choose one of the views.

Event History > Status Change 
Messages

Displays the SGM Network Status Log for Status Change 
Messages in a Web browser, with messages displayed for 
only the selected linkset.

Menu Command Description
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Event History > SNMP Trap Messages Displays the SGM Network Status Log for SNMP Trap 
Messages in a Web browser, with messages displayed for 
only the selected linkset.

Event History > Status and Trap 
Messages

Displays the SGM Network Status Log for Status Change 
Messages and SNMP Trap Messages in a Web browser, 
with messages displayed for only the selected linkset.

Event History > Network Status 
Metrics

Displays the SGM Network Status Log for Metrics in a 
Web browser, with messages displayed for only the 
selected linkset.

Ignore Ignores the selected linkset at the next polling cycle.

If you have implemented SGM User-Based Access, this 
option is available to users with authentication level Power 
User (Level 2) and higher.

Unignore Stops ignoring the selected linkset at the next polling cycle.

If you have implemented SGM User-Based Access, this 
option is available to users with authentication level Power 
User (Level 2) and higher.

Drill-Down > Linkset Access List Opens the Linkset Details: Linkset Access Lists table, 
which displays all access lists associated with the selected 
linkset.

This option is not available if the linkset is in Unknown or 
Unavailable status, or if the linkset is a Virtual linkset.

Latest Reports > Linkset Statistics Displays the most recent Linkset Statistics: Hourly Report 
for the linkset, in a Web browser.

Latest Reports > Linkset Peaks Displays the most recent Linkset Utilization Peaks - 
Rolling 30 Days Report for the linkset, in a Web browser.

Latest Reports > Link Statistics Displays the most recent Link Statistics: Hourly Report for 
the links associated with the linkset, in a Web browser.

Latest Reports > Link Peaks Displays the most recent Link Utilization Peaks - Rolling 
30 Days Report for the links associated with the linkset, in 
a Web browser.

Menu Command Description
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Linkset Table
The linkset table displays information about the linksets that have been 
discovered by SGM.

Linksets that are associated with nodes that are excluded from the current view 
are not displayed in the linkset table. See the “Creating a New View” section on 
page 4-68 for more information about excluding nodes.

To see mouse over help popup for each column in the table, place the cursor over 
a column header.

If a cell is too small to show all of its data, place the cursor over the cell to see the 
full data in a mouse over help popup.

You can resize each column, or sort the table based on the information in one of 
the columns. By default, this table is sorted by Status, and SGM displays all of 
the columns in the Linkset Table except Internal ID, Node, SP, Congested 
Links, and Last Status Change.

• To display hidden columns, right-click in the table header and select the 
checkboxes for the columns you want to display.

• To hide columns, right-click in the table header and clear the checkboxes for 
the columns you want to hide.

See the “Resizing, Sorting, and Hiding Table Columns” section on page 3-53 for 
more information about resizing, sorting, displaying, or hiding columns.

The linkset table contains the following columns:

Column Description

Internal ID Internal ID of the linkset. The internal ID is a unique ID for every object, 
assigned by SGM for its own internal use. It can also be useful when the TAC is 
debugging problems.

Name Name of the linkset.

Node Node associated with the linkset.

Signaling Point Signaling point associated with the linkset.

Local Point Code Point code of the primary signaling point for the linkset.

Adj Point Code Point code of the adjacent signaling point for the linkset.
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Linkset Type Type of linkset, which SGM determines by examining the links defined in the 
linkset. Possible linkset types are:

• HSL—The links in this linkset use the SS7-over-ATM (Asynchronous 
Transfer Mode) high-speed protocol.

• SCTPIP—The links in this linkset use the Stream Control Transmission 
Protocol (SCTP) IP transport protocol.

• Serial—The links in this linkset use the serial SS7 signaling protocol.

• Mixed—The links in this linkset are of two or more types. (This 
configuration is not recommended.)

• Virtual—The links in this linkset are virtual links, which connect signaling 
point instances running on the same device. SGM does not poll virtual 
linksets, nor does it display real-time data or accounting statistics for virtual 
linksets.

Note Prior to IOS release 12.2(23)SW1, virtual linksets on multi-instance 
routers were created manually by the user. Within and after that release, 
virtual linksets are created automatically.

• Other—No links have been defined for this linkset.

Links Total number of links in the linkset.

Active Links Number of links in the linkset that are Active.

Congested Links Number of links in the linkset that are Congested.

Ignored Indicates whether the linkset is to be included when aggregating and displaying 
SGM status information:

• Clear the checkbox to include the linkset. This is the default setting.

• Select the checkbox to exclude the linkset.

This field can be edited by users with authentication level Power User (Level 2) 
and higher.

Notes Indicates whether there is a note associated with the linkset.

Column Description
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Events Indicates whether there is a recent event associated with the linkset. (Even if the 
server purges all of the events associated with the linkset, SGM continues to 
display the event icon in this field.)

• To delete the event icon (orange triangle) from SGM displays for a specific 
linkset, select the linkset and click the icon.

• To delete the event icon from SGM displays for all linksets, select Edit > 
Clear All Events from the SGM Main Menu.

Note During Discovery, SGM might flag most linksets with an event icon. If 
the event icons are too distracting, use the Edit > Clear All Events menu 
option to remove them.

Last Status 
Change

Date and time that the status of the linkset last changed.

Column Description
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Status Current status of the linkset. Possible values are:

Active (green)

Shutdown (blue)

Unavailable (red)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see the “Status Definitions for Linksets” 
section on page A-5.

Status Reason Reason for the current status of the signaling gateway mated pair.

For a full list of possible reasons, see the stateReasons.html file:

• If you installed SGM in the default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• If you installed SGM in a different directory, then the help directory and file 
are located in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full status reason in a mouse over help popup.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude is displayed.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the sgm cleandiscover command to delete all current network data and 
begin a clean discovery of the ITP network. If the status reason is still 
Unsupported Configuration, enter the sgm clean command to restore the SGM 
server to a “clean” state, such as would exist after a new installation of SGM. For 
more information on the use of these commands, see the “SGM Command 
Reference” section on page C-1.

Column Description
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Viewing Detailed Information for a Linkset
SGM enables you to view detailed information about the selected linkset, 
including its associated links, status, and other information.

To display detailed information for a linkset, use one of the following procedures:

• Select Linksets in the left pane of the SGM Main Window, right-click a 
linkset in the right pane, then select View > Configuration Details in the 
right-click menu.

• Select the turner beside Linksets in the left pane of the SGM Main Window, 
then select a linkset.

SGM displays the Linkset Details Window.

Detailed information for the selected linkset is displayed in the left column, and 
for the adjacent linkset in the right column.

Updates for the linkset that are received from the SGM server are reflected 
automatically in this window.

The Linkset Details Window is composed of the following sections:

• Linkset Details: Right-Click Menu, page 8-12

• Linkset Details: Components, page 8-16

• Linkset Details: Configuration Data, page 8-19

• Linkset Details: Notes, page 8-22

• Linkset Details: Recent Events, page 8-22

• Linkset Details: Linkset Access Lists, page 8-27

Related Topics:

• Working with Linksets, page 8-1
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Linkset Details: Right-Click Menu
The Linkset Details Window provides a right-click menu. To see this menu for a 
linkset, select a linkset in the left pane and click the right mouse button. The 
linkset details right-click menu provides the following options:

Menu Command Description

Show In New Window Opens the Linkset Details Window for the selected linkset 
in a new window.

Edit Notes Opens the Edit Notes Dialog for the selected linkset.

If you have implemented SGM User-Based Access, this 
option is available to users with authentication level Power 
User (Level 2) and higher.

Clear Event Icon Deletes the event icon (orange triangle) from SGM 
displays for the selected linkset, for this SGM client only. 
The actual events are not deleted from SGM, only the event 
icon for the selected linkset for this SGM client.

This option is grayed-out if the selected linkset has no 
associated event icon.
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Delete Deletes the currently selected linkset from the SGM 
database. SGM displays the Confirm Deletion dialog:

• To delete the selected linkset, click Yes. The linkset is 
deleted from the SGM database and the Confirm 
Deletion dialog is closed.

• To retain the selected linkset, click No. The linkset is 
kept in the SGM database and the Confirm Deletion 
dialog is closed.

Note If you delete all linksets to an Unmanaged node, 
SGM does not automatically delete the node. 
Instead, you must manually delete the node. See the 
“Deleting a Node” section on page 6-100 for more 
information.

• To prevent SGM from displaying the Confirm Deletion 
dialog, select the Do not show this again checkbox.

Note If you select the Do not show this again checkbox, 
and you later decide you want SGM to begin 
displaying the Confirm Deletion dialog again, you 
must select the Confirm Deletions checkbox in the 
General GUI settings in the Preferences window. 
For more information, see the description of the 
Confirm Deletions checkbox in the “Startup/Exit 
Settings” section on page 23-6.

If you have implemented SGM User-Based Access, this 
option is available to users with authentication level 
Network Administrator (Level 4) and higher.

Go To > SP Displays the Signaling Point Window for the signaling 
point associated with this linkset.

SGM displays two Go To > SP links if both sides are in the 
model.

Menu Command Description
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Go To > Node Displays the Node Window for the node associated with 
this linkset.

SGM displays two Go To > Node links if both sides are in 
the model.

Back > List of Windows Navigates back to a window viewed in this session.

SGM maintains a list of up to 10 Back windows.

Forward > List of Windows Navigates forward to a window viewed in this session.

SGM maintains a list of up to 10 Forward windows.

View > Components Displays the Components panel for the selected linkset.

View > Configuration Details Displays the Configuration Data panel for the selected 
linkset.

View > Notes Displays the Notes panel for the selected linkset.

If there are no notes associated with the selected linkset, 
this option is grayed-out.

View > Events Displays the Recent Events panel for the selected linkset 
and its associated links.

View > Real-Time Data and Charts Displays the Statistics Details Window for the selected 
linkset.

If you have implemented SGM User-Based Access, this 
option is available to users with authentication level Power 
User (Level 2) and higher.

This option is not available if the linkset is in Unknown or 
Unavailable status, or if the linkset is a Virtual linkset.

View > Center in Topo Opens the Topology Window, with the display zoomed to 
center on the selected linkset.

If more than one view contains the selected linkset, SGM 
prompts you to choose one of the views.

Event History > Status Change 
Messages

Displays the SGM Network Status Log for Status Change 
Messages in a Web browser, with messages displayed for 
only the selected linkset.

Menu Command Description
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Event History > SNMP Trap Messages Displays the SGM Network Status Log for SNMP Trap 
Messages in a Web browser, with messages displayed for 
only the selected linkset.

Event History > Status and Trap 
Messages

Displays the SGM Network Status Log for Status Change 
Messages and SNMP Trap Messages in a Web browser, 
with messages displayed for only the selected linkset.

Event History > Network Status 
Metrics

Displays the SGM Network Status Log for Metrics in a 
Web browser, with messages displayed for only the 
selected linkset.

Ignore Ignores the selected linkset at the next polling cycle.

If you have implemented SGM User-Based Access, this 
option is available to users with authentication level Power 
User (Level 2) and higher.

Unignore Stops ignoring the selected linkset at the next polling cycle.

If you have implemented SGM User-Based Access, this 
option is available to users with authentication level Power 
User (Level 2) and higher.

Drill-Down > Linkset Access List Opens the Linkset Details: Linkset Access Lists table, 
which displays all access lists associated with the selected 
linkset.

This option is not available if the linkset is in Unknown or 
Unavailable status, or if the linkset is a Virtual linkset.

Latest Reports > Linkset Statistics Displays the most recent Linkset Statistics: Hourly Report 
for the linkset, in a Web browser.

Latest Reports > Linkset Peaks Displays the most recent Linkset Utilization Peaks - 
Rolling 30 Days Report for the linkset, in a Web browser.

Latest Reports > Link Statistics Displays the most recent Link Statistics: Hourly Report for 
the links associated with the linkset, in a Web browser.

Latest Reports > Link Peaks Displays the most recent Link Utilization Peaks - Rolling 
30 Days Report for the links associated with the linkset, in 
a Web browser.

Menu Command Description
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Linkset Details: Components
The Linkset Details: Components section displays information about the links 
that are associated with the selected linkset. (If the linkset is not associated with 
any links, the Linkset Details: Components section is empty.)

To see mouse over help popup for each column in the table, place the cursor over 
a column header.

If a cell is too small to show all of its data, place the cursor over the cell to see the 
full data in a mouse over help popup.

You can resize each column, or sort the table based on the information in one of 
the columns. By default, SGM displays all of the columns in the link table except 
Internal ID, Congestion Level, and Last Status Change.

• To display hidden columns, right-click in the table header and select the 
checkboxes for the columns you want to display.

• To hide columns, right-click in the table header and clear the checkboxes for 
the columns you want to hide.

See the “Resizing, Sorting, and Hiding Table Columns” section on page 3-53 for 
more information about resizing, sorting, displaying, or hiding columns.

The link table contains the following columns:

Column Description

Internal ID Internal ID of the link. The internal ID is a unique ID for every object, assigned 
by SGM for its own internal use. It can also be useful when the TAC is debugging 
problems.

Node Name of the node associated with the link.

Signaling Point Name of the signaling point associated with the link.

Linkset Name of the linkset associated with the link.

SLC Signaling link code (SLC) ID for the link.
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Type Type of link. Possible link types are:

• HSL—The link uses the SS7-over-ATM (Asynchronous Transfer Mode) 
high-speed protocol.

• SCTPIP—The link uses the Stream Control Transmission Protocol (SCTP) 
IP transport protocol.

• Serial—The link uses the serial SS7 signaling protocol.

• Virtual—The link is a virtual link, which connects signaling point instances 
running on the same device. SGM does not poll virtual links, nor does it 
display real-time data or accounting statistics for virtual links.

Congestion Level Indicates whether there is congestion on the link. A link is congested if it has too 
many packets waiting to be sent. This condition could be caused by the failure of 
an element in your network.

Possible values for the Congestion Level field are None, indicating no 
congestion, and 1 to 7, indicating levels of congestion from very light (1) to very 
heavy (7).

Ignored Indicates whether the link is to be included when aggregating and displaying 
SGM status information:

• Clear the checkbox to include the link. This is the default setting.

• Select the checkbox to exclude the link.

This field can be edited by users with authentication level Power User (Level 2) 
and higher.

Notes Indicates whether there is a note associated with the link.

Events Indicates whether there is a recent event associated with the link. (Even if the 
server purges all of the events associated with the link, SGM continues to display 
the event icon in this field.)

• To delete the event icon (orange triangle) from SGM displays for a specific 
link, select the link and click the icon.

• To delete the event icon from SGM displays for all links, select Edit > Clear 
All Events from the SGM Main Menu.

Note During Discovery, SGM might flag most links with an event icon. If the 
event icons are too distracting, use the Edit > Clear All Events menu 
option to remove them.

Column Description
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Last Status 
Change

Date and time that the status of the link last changed.

Status Current status of the link. Possible values are:

Active (green)

Blocked (red)

Failed (red)

InhibitLoc (blue)

InhibitRem (blue)

Shutdown (blue)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see the “Status Definitions for Links” 
section on page A-4.

Status Reason Reason for the current status of the signaling gateway mated pair.

For a full list of possible reasons, see the stateReasons.html file:

• If you installed SGM in the default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• If you installed SGM in a different directory, then the help directory and file 
are located in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full status reason in a mouse over help popup.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude is displayed.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the sgm cleandiscover command to delete all current network data and 
begin a clean discovery of the ITP network. If the status reason is still 
Unsupported Configuration, enter the sgm clean command to restore the SGM 
server to a “clean” state, such as would exist after a new installation of SGM. For 
more information on the use of these commands, see the “SGM Command 
Reference” section on page C-1.

Column Description
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Linkset Details: Configuration Data
The Linkset Details: Configuration Data section is composed of the following 
sub-sections:

• Naming Information, page 8-19

• Status Information, page 8-19

• Description, page 8-20

• General Information, page 8-21

• Links Information, page 8-22

Configuration data for the selected linkset is displayed in the left column, and for 
the adjacent linkset in the right column.

Naming Information

The Naming Information sub-section contains the following fields:

Status Information

The Status Information sub-section contains the following fields:

Field Description

Name Name of the linkset.

Node Node associated with the linkset.

Signaling Point Signaling point associated with the linkset.

Local Point Code Point code of the primary signaling point for the linkset.

Adj Point Code Point code of the adjacent signaling point for the linkset.

Field Description

Is Ignored Indicates whether the linkset is Ignored (that is, whether the linkset is to be 
included when aggregating and displaying SGM status information).

Last Status Change Date and time that the status of the linkset last changed.
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Description

The Description sub-section contains a description of the linkset. If the linkset has 
no description, this sub-section is blank.

Status Current status of the linkset. Possible values are:

Active (green)

Shutdown (blue)

Unavailable (red)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see the “Status Definitions for Linksets” 
section on page A-5.

Status Reason Reason for the current status of the signaling gateway mated pair.

For a full list of possible reasons, see the stateReasons.html file:

• If you installed SGM in the default directory, /opt, then the file is located 
at /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• If you installed SGM in a different directory, then the help directory and 
file are located in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full status reason in a mouse over help popup.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude is displayed.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the sgm cleandiscover command to delete all current network data 
and begin a clean discovery of the ITP network. If the status reason is still 
Unsupported Configuration, enter the sgm clean command to restore the 
SGM server to a “clean” state, such as would exist after a new installation of 
SGM. For more information on the use of these commands, see the “SGM 
Command Reference” section on page C-1.

Field Description
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General Information

The General Information sub-section contains the following fields:

Field Description

Linkset Type Type of linkset, which SGM determines by examining the links defined in the 
linkset. Possible linkset types are:

• HSL—The links in this linkset use the SS7-over-ATM (Asynchronous 
Transfer Mode) high-speed protocol.

• SCTPIP—The links in this linkset use the Stream Control Transmission 
Protocol (SCTP) IP transport protocol.

• Serial—The links in this linkset use the serial SS7 signaling protocol.

• Mixed—The links in this linkset are of two or more types. (This 
configuration is not recommended.)

• Virtual—The links in this linkset are virtual links, which connect 
signaling point instances running on the same device. SGM does not poll 
virtual linksets, nor does it display real-time data or accounting statistics 
for virtual linksets.

Note Prior to IOS release 12.2(23)SW1, virtual linksets on multi-instance 
routers were created manually by the user. Within and after that 
release, virtual linksets are created automatically.

• Other—No links have been defined for this linkset.

Inbound ACL Inbound IP access control list (ACL) number for the linkset.

If there is no inbound ACL for the linkset, this field displays 0.

If the linkset is a Virtual linkset, this field displays N/A.

Outbound ACL Outbound ACL number for the linkset.

If there is no outbound ACL for the linkset, this field displays 0.

If the linkset is a Virtual linkset, this field displays N/A.
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Links Information

The Links Information sub-section contains the following fields:

Linkset Details: Notes
The Linkset Details: Notes section displays:

• Notes associated with the selected linkset in the left column.

• Notes associated with the adjacent linkset in the right column.

• The date and time the notes associated with each linkset were last updated, or 
the phrase Not Set if there are no notes associated with the linkset.

• The phrase No Notes if there are no notes associated with the linkset.

Linkset Details: Recent Events
The Linkset Details: Recent Events table displays information about all recent 
events associated with the linkset, and enables you to perform event-related tasks, 
such as setting filters and acknowledging events.

To see mouse over help popup for each column in the table, place the cursor over 
a column header.

If a cell is too small to show all of its data, place the cursor over the cell to see the 
full data in a mouse over help popup.

You can resize each column, or sort the table based on the information in one of 
the columns. By default, SGM displays all of the columns in the table except 
Internal ID, Note, Message Name, Ack By, Ack Time, Node, SP, Linkset, 
Link, SGMP, ASP, AS, ASPA, Probe Conn, and Probe Link.

Field Description

Links Total number of links in the linkset.

Active Links Number of links in the linkset that are Active.

Congested Links Number of links in the linkset that are Congested.
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• To display hidden columns, right-click in the table header and select the 
checkboxes for the columns you want to display.

• To hide columns, right-click in the table header and clear the checkboxes for 
the columns you want to hide.

See the “Resizing, Sorting, and Hiding Table Columns” section on page 3-53 for 
more information about resizing, sorting, displaying, or hiding columns.

The Linkset Details: Recent Events table contains the following toolbar buttons 
and columns:

Toolbar Button or Column Description

Set Filter Opens the Event Filter dialog.

Apply Filter

or

Remove Filter

Activates and deactivates the event filter specified in the Event Filter 
dialog:

• If the filter is activated, SGM displays only those events that pass 
the filter.

• If the filter is deactivated, SGM displays all events.

• If you activate a filter in an object’s Recent Events table in the SGM 
Main Window, the filter is activated in all Recent Events tables in 
the SGM Main Window for all other objects. The filter is not 
activated in Recent Events tables in Show In New Window windows 
or Real-Time Data and Charts windows.

Pause

or

Resume

Pauses or resumes the table.

While the table is paused, SGM does not display new events in the table 
(unless you apply an event filter or edit your event preferences). When 
the table is resumed, all new events since the table was paused are added 
to the display.

If events are deleted while the table is paused, they are not removed from 
the table. Instead, they are grayed-out and cannot be acknowledged or 
edited. Deleted events are removed from the table when you resume the 
table.

Acknowledge Makes the selected event or events acknowledged.

Unacknowledge Makes the selected event or events unacknowledged.

Event Properties Opens the Event Properties window.
8-23
Cisco Signaling Gateway Manager User Guide

OL-7064-01



 

Chapter 8      Working with Linksets
    Viewing Detailed Information for a Linkset
Edit Notes Opens the Edit Event Dialog.

Time Difference Displays the difference in days, minutes, hours, and seconds between 
two events.

Find Finds specific text in the event table.

Create Sound Filter Opens the Event Sound Filters dialog and the Event Sound Filters List 
dialog, with fields populated based on the selected event.

Adjust Row Height Adjusts the table row height and wraps the message text as follows:

• Click once to double the row height and wrap the message text.

• Click again to triple the row height and wrap the message text.

• Click again for single row height and no message text wrapping. 
This is the default setting.

This setting is saved automatically with your preferences.

Help for Event Displays context-sensitive help for the selected event in a separate Web 
browser.

Internal ID Internal ID of the event. The internal ID is a unique ID for every object, 
assigned by SGM for its own internal use. It can also be useful when the 
TAC is debugging problems.

Ack Indicates whether the event has been acknowledged:

• To acknowledge an unacknowledged event, use the Acknowledge 
toolbar button.

• To make a previously acknowledged event unacknowledged, use the 
Unacknowledge toolbar button.

Toolbar Button or Column Description
8-24
Cisco Signaling Gateway Manager User Guide

OL-7064-01



 

Chapter 8      Working with Linksets
    Viewing Detailed Information for a Linkset
Category Type of the event. Default values are:

• Create—Creation event, such as the creation of a seed file.

• Delete—Deletion event, such as the deletion of an object or file.

• Discover—Discovery event, such as Discovery beginning.

• Edit—Edit event. A user has edited an object.

• Ignore—Ignore event. A user has Ignored a link or linkset.

• Login—Login event. A user has logged in to SGM.

• LoginDisable—LoginDisable event. SGM has disabled a user’s 
User-Based Access authentication as a result of too many failed 
attempts to log in to SGM.

• LoginFail—LoginFail event. An attempt by a user to log in to SGM 
has failed.

• Logout—Logout event. A user has logged out of SGM.

• OverWrite—OverWrite event. An existing file, such as a seed file 
or route file, has been overwritten.

• Poll—Poll event, such as an SNMP poll.

• Purge—Purge event. A user has requested Discovery with Delete 
Existing Data selected, and SGM has deleted the existing SGM 
database.

• Status—Status change message generated.

• Trap—SNMP trap message generated.

You can customize this field. See the “Changing Event Categories” 
section on page 5-34 for more information.

Toolbar Button or Column Description
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Severity Severity of the event. Default values are:

• Admin—The default color is cyan.

• Error—The default color is coral.

• None—The default color is white.

• Normal—The default color is light green.

• Warning—The default color is yellow.

You can customize this field. See the “Changing Event Severities and 
Colors” section on page 5-35 for more information.

Note Indicates whether there is a note associated with the event.

Message Name User-specified message name for the event, used by SGM for trap 
forwarding. The default message name is SGM.

For more information about user-specified message names and trap 
forwarding, see the “Forwarding Events as Traps to Other Hosts” section 
on page 5-46.

Time Date and time the event was logged.

Ack By If you have not implemented SGM User-Based Access, name of the 
device that last acknowledged the event.

If you have implemented SGM User-Based Access, name of the user 
who last acknowledged the event.

If no one has acknowledged the event, this field is blank.

Ack Time Date and time the event was last acknowledged or unacknowledged.

Node Name of the node associated with the event. If there is no node 
associated with the event, None is displayed.

SP Name of the signaling point associated with the event. If there is no 
signaling point associated with the event, None is displayed.

Linkset Name of the linkset associated with the event. If there is no linkset 
associated with the event, None is displayed.

Link Name of the link associated with the event. If there is no link associated 
with the event, None is displayed.

Toolbar Button or Column Description
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Linkset Details: Linkset Access Lists
The Linkset Details: Linkset Access Lists section displays information about the 
access lists associated with the selected linkset and its adjacent linkset.

Note This window polls your network periodically. To prevent unnecessary traffic on 
your network, close this window when you no longer need to refer to it.

This window is not available if the linkset is a Virtual linkset.

SGMP Name of the signaling gateway mated pair associated with the event. If 
there is no signaling gateway mated pair associated with the event, None 
is displayed.

ASP Name of the application server process associated with the event. If 
there is no application server process associated with the event, None is 
displayed.

AS Name of the application server associated with the event. If there is no 
application server associated with the event, None is displayed.

ASPA Name of the application server process association associated with the 
event. If there is no application server process association associated 
with the event, None is displayed.

Probe Conn Name of the probe connection associated with the event. If there is no 
probe connection associated with the event, None is displayed.

Probe Link Name of the probe link associated with the event. If there is no probe 
link associated with the event, None is displayed.

Message Text of the message.

You can customize this field. See the “Changing the Way SGM 
Processes Events” section on page 5-28 for more information.

Toolbar Button or Column Description
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For each linkset, the Linkset Details: Linkset Access Lists section displays the 
following information:

Viewing Real-Time Data for a Linkset
SGM enables you to view detailed statistics for a selected linkset, including its 
associated links, status, and other information. Detailed information for the 
selected linkset is displayed in the left column, and for the adjacent linkset in the 
right column.

To display detailed statistics for a linkset, select Linksets in the left pane of the 
SGM Main Window, right-click a linkset in the right pane, then select View > 
Real-Time Data and Charts in the right-click menu. SGM displays the Statistics 
Details Window for a Linkset.

Updates for the linksets that are received from the SGM server are reflected 
automatically in this window.

Changes you make in this window might not be reflected throughout SGM until 
the next poll (by default, every 15 seconds). For information about changing the 
poll interval, see the “Linkset Statistics Details: Poll Settings” section on 
page 8-29.

Column Description

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the phrase Polling device. After the first polling cycle, 
SGM populates this field with the actual time of the last poll.

Linkset Name of the linkset for which access lists are being displayed.

In Inbound access lists for the linkset. If the linkset has no inbound access lists, this 
field displays None.

Out Outbound access lists for the linkset. If the linkset has no outbound access lists, this 
field displays None.

List # Access list number configured on the node and applied to the linkset. ITP uses 
access list numbers 2700 through 2799.

Access List List of commands in the access list.
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Note This window polls your network periodically. To prevent unnecessary traffic on 
your network, close this window when you no longer need to refer to it.

The Statistic Details Window for a Linkset is composed of the following sections:

• Linkset Statistics Details: Poll Settings, page 8-29

• Linkset Statistics Details: Configuration Data, page 8-30

• Linkset Statistics Details: Notes, page 8-30

• Linkset Statistics Details: Recent Events, page 8-31

• Linkset Statistics Details: Linkset Access Lists, page 8-31

• Linkset Statistics Details: Statistics, page 8-31

• Linkset Statistics Details: Charts, page 8-35

Related Topics:

• Viewing Detailed Information for a Linkset, page 8-11

• Working with Linksets, page 8-1

Linkset Statistics Details: Poll Settings
To view or change poll settings for the Linkset Statistics Details Window, select 
Poll Settings in the left pane. SGM displays the Linkset Statistics Details Poll 
Settings panel in the right pane.

The Linkset Statistics Details Poll Settings panel contains the following fields:

Field Description

Poll Interval (secs) New poll interval for the Linkset Statistics Details Window, in 
seconds.

Enter the new poll interval in this field. The valid range is 15 seconds 
to an unlimited number of seconds. The default value is 15 seconds.

Current Poll Interval Current poll interval for the Linkset Statistics Details Window, in 
seconds.
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Linkset Statistics Details: Configuration Data
The information presented in the Linkset Statistics Details: Configuration Data 
section is the same as that presented by the “Linkset Details: Configuration Data” 
section on page 8-19.

Linkset Statistics Details: Notes
The information presented in the Linkset Statistics Details: Notes section is the 
same as that presented by the “Linkset Details: Notes” section on page 8-22.

Number of Polls Received Total number of polls received since polling began for the Linkset 
Statistics Details Window.

Running Time Total elapsed time since polling began for the Linkset Statistics 
Details Window.

Last Message Date and time of the last poll for the Linkset Statistics Details 
Window.

Poll Counter Mode Displays the current mode for poll counters, and the date and time that 
counters were last reset. Possible modes are:

• Since Reboot—Counters display values aggregated since the last 
reboot of the ITP, or since ITP last reset the counters.

• Since Last Poll—Counters display values aggregated since the 
last poll.

• Since User Reset—Counters display values aggregated since the 
last time they were reset by the user.

Reset Counters Opens the SGM Reset Counters Dialog, which enables you to change 
SGM poller and counter settings. For more information, see the 
“Changing Real-Time Poller and Counter Settings” section on 
page 3-78.

Field Description
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Linkset Statistics Details: Recent Events
The information presented in the Linkset Statistics Details: Recent Events section 
is the same as that presented by the “Linkset Details: Recent Events” section on 
page 8-22.

Linkset Statistics Details: Linkset Access Lists
The information presented in the Linkset Statistics Details: Linkset Access Lists 
section is the same as that presented by the “Linkset Details: Linkset Access 
Lists” section on page 8-27.

Linkset Statistics Details: Statistics
The Linkset Statistics Details: Statistics section is composed of the following 
sub-sections:

• Packet Information, page 8-32

• Bit Information or Byte Information, page 8-32

• Utilization Information, page 8-33

• Service Information, page 8-35

Statistics for the selected linkset are displayed in the left column, and for the 
adjacent linkset in the right column.
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Packet Information

The Packet Information sub-section contains the following fields:

Bit Information or Byte Information

The Bit Information sub-section (or Byte Information sub-section, if you cleared 
the Show Details in Bits Instead of Bytes checkbox in the Preferences Window) 
contains the following fields:

Field Description

Sent Per Sec Number of packets sent by the linkset per second.

This field initially displays the phrase Waiting for second poll. After two polling 
cycles, SGM populates this field with actual calculated rates.

Received Per Sec Number of packets received by the linkset per second.

This field initially displays the phrase Waiting for second poll. After two polling 
cycles, SGM populates this field with actual calculated rates.

Drops Total number of packets that have been dropped by the linkset.

Field Description

Sent Per Sec Number of bits or bytes (as set in the Preferences window) sent by the 
linkset per second.

This field initially displays the phrase Waiting for second poll. After two 
polling cycles, SGM populates this field with actual calculated rates.

Received Per Sec Number of bits or bytes (as set in the Preferences window) received by the 
linkset per second.

This field initially displays the phrase Waiting for second poll. After two 
polling cycles, SGM populates this field with actual calculated rates.
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Utilization Information

The Utilization Information sub-section contains the following fields:

Field Description

Send Plan Capacity Planned capacity of the linkset to send, in bits per second.

• For a linkset of type Serial or HSL, available bandwidth for the linkset.

• For a linkset of type SCTPIP or Mixed, set on the ITP using the 
plan-capacity CS7 linkset configuration command.

If Send Plan Capacity is not set on the ITP for one or more of the links 
associated with this linkset, this field displays the value 0.

• For a linkset of type Other, this field always displays the value 0.

Send Utilization % Amount of the linkset’s send capacity being used, as a percentage or in 
Erlangs (as set in the Preferences window), calculated using the following 
formula:

Send Utilization % = (Bits Sent Per Sec)/Planned Capacity

This field initially displays the phrase Waiting for second poll. After two 
polling cycles, SGM populates this field with actual calculated rates.

• For a linkset of type SCTPIP or Mixed, if Send Plan Capacity is not 
set on the ITP for one or more of the links associated with this linkset, 
this field displays the phrase Set Plan Capacity on ITP.

• For a linkset of type Other, this field always displays the phrase Set 
Plan Capacity on ITP.
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Receive Plan Capacity Planned capacity of the linkset to receive, in bits per second.

• For a linkset of type Serial or HSL, available bandwidth for the linkset.

• For a linkset of type SCTPIP or Mixed, set on the ITP using the 
plan-capacity CS7 linkset configuration command.

If Receive Plan Capacity is not set on the ITP for one or more of the 
links associated with this linkset, this field displays the value 0.

• For a linkset of type Other, this field always displays the value 0.

Receive Utilization % Amount of the linkset’s receive capacity being used, as a percentage or in 
Erlangs (as set in the Preferences window), calculated using the following 
formula:

Receive Utilization = (Bits Received Per Sec)/Receive Plan Capacity

This field initially displays the phrase Waiting for second poll. After two 
polling cycles, SGM populates this field with actual calculated rates.

• For a linkset of type SCTPIP or Mixed, if Receive Plan Capacity is 
not set on the ITP for one or more of the links associated with this 
linkset, this field displays the phrase Set Plan Capacity on ITP.

• For a linkset of type Other, this field always displays the phrase Set 
Plan Capacity on ITP.

Field Description
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Service Information

The Service Information sub-section contains the following fields:

Linkset Statistics Details: Charts
The Linkset Statistics Details: Charts section is composed of the following 
sub-sections:

• ReceivedUtilization, page 8-36

• SendUtilization, page 8-40

• PktsRcvdPerSec, page 8-43

• PktsSentPerSec, page 8-45

• BitsRcvdPerSec or BytesRcvdPerSec, page 8-47

• BitsSentPerSec or BytesSentPerSec, page 8-49

• Drops, page 8-51

Field Description

MTP3 Accounting 
Enabled

Indicates whether the collection of MTP3 accounting statistics is enabled 
for the linkset.

If the linkset is a Virtual linkset, this field displays N/A.

GTT Accounting 
Enabled

Indicates whether the collection of GTT accounting statistics is enabled for 
the linkset.

For Cisco IOS software releases prior to 12.2(4)MB10, this field displays 
Unknown.

If the linkset is a Virtual linkset, this field displays N/A.

Duration In Service % Percentage of time the linkset has been in service since the last reboot of the 
ITP, or since ITP last reset the counters.

Duration Out Of 
Service %

Percentage of time the linkset has been out of service since the last reboot 
of the ITP, or since ITP last reset the counters.
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ReceivedUtilization

SGM enables you to view real-time Received Utilization information for the 
selected linkset. To do so, select the Charts tab in the Statistic Details Window 
for a Linkset, then select the ReceivedUtilization tab. SGM displays the 
ReceivedUtilization chart (Figure 8-1).

Figure 8-1 ReceivedUtilization Chart for a Linkset
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The ReceivedUtilization chart contains the following fields and buttons:

Field or Button Description

Linkset Drop-down list box used to select the linkset for which data is to be displayed.

By default, data is displayed for the selected linkset. To display data for the 
adjacent linkset, select it in this list box.

Time Window (mins) Drop-down list box used to specify the length of time displayed in the 
Received Utilization Chart.

Valid selections are 1, 2, 5, 10, 20, 40, or 60 minutes. The default selection is 
5 minutes.
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Received Utilization 
Chart

Displays the average Receive Utilization % for all links on the linkset as a 
function of time, and optionally the Receive Utilization % for up to 16 
individual links on the linkset.

To see the exact time and data coordinates for a data point, left-click the data 
point. The coordinates are displayed in the format (hh:mm:ss, dd.dd), where:

• hh:mm:ss is the time for that data point in hours, minutes, and seconds.

• dd.dd is the receive utilization percentage for that data point.

Note For serial and HSL links on Cisco 7507 and 7513 series routers, the 
displayed utilization data can vary by up to 5% from the actual 
utilization—SGM might even display utilization data above 100%. 
This variance results from the synchronization of Layer 2 counters 
between the Versatile Interface Processor (VIP) CPU and the Route 
Switch Processor (RSP) CPU on 7500 series routers. This variance 
does not occur for links on Cisco 2600, 7200, or 7300 series routers.

To remove the data for a link or for the average from the chart, click the icon 
in the SLC field. To return the data to the chart, click the icon again.

The total time displayed in the chart is specified in the Time Window (mins) 
field.

New data points are added to the right side of the chart. When the chart 
reaches the end of the time window (for example, after 5 minutes, if the Time 
Window (mins) field is set to 5), new data points continue to be added to the 
right side of the chart, while old data points “drop off” the left side of the 
chart.

If a poll is missed (for example, as a result of an SNMP timeout), SGM 
ignores the missing data point, stops drawing the line, and waits for the next 
valid data point to begin drawing the line again.

To scroll left, right, up, or down in the chart, drag the cursor while holding 
down Ctrl and the left mouse button.

To zoom in on a section of the chart, drag the cursor while holding down Shift 
and the left mouse button.

To reset the chart to the default view and scaling, click Reset.

Field or Button Description
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SLC Displays up to 17 color-coded icons:

• One for each link (SLC) in the Received Utilization Chart, up to 16 total 
links.

• One for the average of all SLCs.

To remove the data for a link or for the average from the chart, click the icon 
in this field. To return the data to the chart, click the icon again.

SGM enables you to customize the symbols, line styles, and colors assigned 
to data points in real-time data charts. For more information, see the Charts 
Settings, page 23-13.

Show threshold line 
for:

Draws a horizontal line on the Received Utilization Chart, indicating the 
receive threshold for the selected link.

If you do not want to draw a threshold line, select None. This is the default 
setting.

Scale to threshold Scales the Received Utilization Chart in order to draw the threshold selected 
in the Show threshold line for field:

• To scale the chart, select this checkbox.

• To remove the scaling from the chart, clear this checkbox. This is the 
default setting.

The Scale to threshold checkbox is not available if the Show threshold line 
for: field is set to None.

Reset If you scrolled or zoomed the chart, resets the chart to the default view and 
scaling.

Grid On Superimposes a graphic grid on the chart. The grid can make the data easier 
to read.

Grid Off Removes the graphic grid from the chart.

Help Displays online help for the current window.

Field or Button Description
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SendUtilization

SGM enables you to view real-time SendUtilization information for the selected 
linkset. To do so, select the Charts tab in the Statistic Details Window for a 
Linkset, then select the SendUtilization tab. SGM displays the SendUtilization 
chart.

The SendUtilization chart contains the following fields and buttons:

Field or Button Description

Linkset Drop-down list box used to select the linkset for which data is to be displayed.

By default, data is displayed for the selected linkset. To display data for the 
adjacent linkset, select it in this list box.

Time Window (mins) Drop-down list box used to specify the length of time displayed in the Send 
Utilization Chart.

Valid selections are 1, 2, 5, 10, 20, 40, or 60 minutes. The default selection is 
5 minutes.
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Send Utilization 
Chart

Displays the average Send Utilization % for all links on the linkset as a 
function of time, and optionally the Send Utilization % for up to 16 
individual links on the linkset.

To see the exact time and data coordinates for a data point, left-click the data 
point. The coordinates are displayed in the format (hh:mm:ss, dd.dd), where:

• hh:mm:ss is the time for that data point in hours, minutes, and seconds.

• dd.dd is the send utilization percentage for that data point.

Note For serial and HSL links on Cisco 7507 and 7513 series routers, the 
displayed utilization data can vary by up to 5% from the actual 
utilization—SGM might even display utilization data above 100%. 
This variance results from the synchronization of Layer 2 counters 
between the Versatile Interface Processor (VIP) CPU and the Route 
Switch Processor (RSP) CPU on 7500 series routers. This variance 
does not occur for links on Cisco 2600, 7200, or 7300 series routers.

To remove the data for a link or for the average from the chart, click the icon 
in the SLC field. To return the data to the chart, click the icon again.

The total time displayed in the chart is specified in the Time Window (mins) 
field.

New data points are added to the right side of the chart. When the chart 
reaches the end of the time window (for example, after 5 minutes, if the Time 
Window (mins) field is set to 5), new data points continue to be added to the 
right side of the chart, while old data points “drop off” the left side of the 
chart.

If a poll is missed (for example, as a result of an SNMP timeout), SGM 
ignores the missing data point, stops drawing the line, and waits for the next 
valid data point to begin drawing the line again.

To scroll left, right, up, or down in the chart, drag the cursor while holding 
down Ctrl and the left mouse button.

To zoom in on a section of the chart, drag the cursor while holding down Shift 
and the left mouse button.

To reset the chart to the default view and scaling, click Reset.

Field or Button Description
8-41
Cisco Signaling Gateway Manager User Guide

OL-7064-01



 

Chapter 8      Working with Linksets
    Viewing Real-Time Data for a Linkset
SLC Displays up to 17 color-coded icons:

• One for each link (SLC) in the Send Utilization Chart, up to 16 total 
links.

• One for the average of all SLCs.

To remove the data for a link or for the average from the chart, click the icon 
in this field. To return the data to the chart, click the icon again.

SGM enables you to customize the symbols, line styles, and colors assigned 
to data points in real-time data charts. For more information, see the Charts 
Settings, page 23-13.

Show threshold line 
for:

Draws a horizontal line on the Send Utilization Chart, indicating the send 
threshold for the selected link.

If you do not want to draw a threshold line, select None. This is the default 
setting.

Scale to threshold Scales the Send Utilization Chart in order to draw the threshold selected in 
the Show threshold line for field:

• To scale the chart, select this checkbox.

• To remove the scaling from the chart, clear this checkbox. This is the 
default setting.

The Scale to threshold checkbox is not available if the Show threshold line 
for: field is set to None.

Reset If you scrolled or zoomed the chart, resets the chart to the default view and 
scaling.

Grid On Superimposes a graphic grid on the chart. The grid can make the data easier 
to read.

Grid Off Removes the graphic grid from the chart.

Help Displays online help for the current window.

Field or Button Description
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PktsRcvdPerSec

SGM enables you to view real-time packets-received-per-second information for 
the selected linkset. To do so, select the Charts tab in the Statistic Details 
Window for a Linkset, then select the PktsRcvdPerSec tab. SGM displays the 
PktsRcvdPerSec chart.

The PktsRcvdPerSec chart contains the following fields and buttons:

Field or Button Description

Linkset Drop-down list box used to select the linkset for which data is to be displayed.

By default, data is displayed for the selected linkset. To display data for the 
adjacent linkset, select it in this list box.

Time Window (mins) Drop-down list box used to specify the length of time displayed in the 
Packets Received Chart.

Valid selections are 1, 2, 5, 10, 20, 40, or 60 minutes. The default selection is 
5 minutes.
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Packets Received 
Chart

Displays the Packets Received Per Sec for the linkset as a function of time, 
including data for up to 16 links.

To see the exact time and data coordinates for a data point, left-click the data 
point. The coordinates are displayed in the format (hh:mm:ss, dd.dd), where:

• hh:mm:ss is the time for that data point in hours, minutes, and seconds.

• dd.dd is the number of packets received per second for that data point.

To remove the data for a link from the chart, click the icon in the SLC field. 
To return the data to the chart, click the icon again.

The total time displayed in the chart is specified in the Time Window (mins) 
field.

New data points are added to the right side of the chart. When the chart 
reaches the end of the time window (for example, after 5 minutes, if the Time 
Window (mins) field is set to 5), new data points continue to be added to the 
right side of the chart, while old data points “drop off” the left side of the 
chart.

If a poll is missed (for example, as a result of an SNMP timeout), SGM 
ignores the missing data point, stops drawing the line, and waits for the next 
valid data point to begin drawing the line again.

To scroll left, right, up, or down in the chart, drag the cursor while holding 
down Ctrl and the left mouse button.

To zoom in on a section of the chart, drag the cursor while holding down Shift 
and the left mouse button.

To reset the chart to the default view and scaling, click Reset.

SLC Displays up to 16 color-coded icons, one for each link (SLC) in the Packets 
Received Chart.

To remove the data for a link from the chart, click the icon in this field. To 
return the data to the chart, click the icon again.

SGM enables you to customize the symbols, line styles, and colors assigned 
to data points in real-time data charts. For more information, see the Charts 
Settings, page 23-13.

Reset If you scrolled or zoomed the chart, resets the chart to the default view and 
scaling.

Field or Button Description
8-44
Cisco Signaling Gateway Manager User Guide

OL-7064-01



 

Chapter 8      Working with Linksets
    Viewing Real-Time Data for a Linkset
PktsSentPerSec

SGM enables you to view real-time packets-sent-per-second information for the 
selected linkset. To do so, select the Charts tab in the Statistic Details Window 
for a Linkset, then select the PktsSentPerSec tab. SGM displays the 
PktsSentPerSec chart.

The PktsSentPerSec chart contains the following fields and buttons:

Grid On Superimposes a graphic grid on the chart. The grid can make the data easier 
to read.

Grid Off Removes the graphic grid from the chart.

Help Displays online help for the current window.

Field or Button Description

Field or Button Description

Linkset Drop-down list box used to select the linkset for which data is to be displayed.

By default, data is displayed for the selected linkset. To display data for the 
adjacent linkset, select it in this list box.

Time Window (mins) Drop-down list box used to specify the length of time displayed in the 
Packets Sent Chart.

Valid selections are 1, 2, 5, 10, 20, 40, or 60 minutes. The default selection is 
5 minutes.
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Packets Sent Chart Displays the Packets Sent Per Sec for the linkset as a function of time, 
including data for up to 16 links.

To see the exact time and data coordinates for a data point, left-click the data 
point. The coordinates are displayed in the format (hh:mm:ss, dd.dd), where:

• hh:mm:ss is the time for that data point in hours, minutes, and seconds.

• dd.dd is the number of packets sent per second for that data point.

To remove the data for a link from the chart, click the icon in the SLC field. 
To return the data to the chart, click the icon again.

The total time displayed in the chart is specified in the Time Window (mins) 
field.

New data points are added to the right side of the chart. When the chart 
reaches the end of the time window (for example, after 5 minutes, if the Time 
Window (mins) field is set to 5), new data points continue to be added to the 
right side of the chart, while old data points “drop off” the left side of the 
chart.

If a poll is missed (for example, as a result of an SNMP timeout), SGM 
ignores the missing data point, stops drawing the line, and waits for the next 
valid data point to begin drawing the line again.

To scroll left, right, up, or down in the chart, drag the cursor while holding 
down Ctrl and the left mouse button.

To zoom in on a section of the chart, drag the cursor while holding down Shift 
and the left mouse button.

To reset the chart to the default view and scaling, click Reset.

SLC Displays up to 16 color-coded icons, one for each link (SLC) in the Packets 
Sent Chart.

To remove the data for a link from the chart, click the icon in this field. To 
return the data to the chart, click the icon again.

SGM enables you to customize the symbols, line styles, and colors assigned 
to data points in real-time data charts. For more information, see the Charts 
Settings, page 23-13.

Reset If you scrolled or zoomed the chart, resets the chart to the default view and 
scaling.

Field or Button Description
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BitsRcvdPerSec or BytesRcvdPerSec

SGM enables you to view real-time bits-received-per-second information for the 
selected linkset (or bytes-received-per-second information, if you cleared the 
Show Details in Bits Instead of Bytes checkbox in the Preferences Window). To 
do so, select the Charts tab in the Statistic Details Window for a Linkset, then 
select the BitsRcvdPerSec or BytesRcvdPerSec tab. SGM displays the 
BitsRcvdPerSec or BytesRcvdPerSec chart.

The BitsRcvdPerSec chart (or BytesRcvdPerSec chart, if you cleared the Show 
Details in Bits Instead of Bytes checkbox in the Preferences Window) contains 
the following fields and buttons:

Grid On Superimposes a graphic grid on the chart. The grid can make the data easier 
to read.

Grid Off Removes the graphic grid from the chart.

Help Displays online help for the current window.

Field or Button Description

Field or Button Description

Linkset Drop-down list box used to select the linkset for which data is to be displayed.

By default, data is displayed for the selected linkset. To display data for the 
adjacent linkset, select it in this list box.

Time Window (mins) Drop-down list box used to specify the length of time displayed in the Bits 
Received Chart or Bytes Received Chart.

Valid selections are 1, 2, 5, 10, 20, 40, or 60 minutes. The default selection is 
5 minutes.
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Bits Received Chart
or
Bytes Received Chart

Displays the Bits Received Per Sec or Bytes Received Per Sec for the linkset 
as a function of time, including data for up to 16 links.

To see the exact time and data coordinates for a data point, left-click the data 
point. The coordinates are displayed in the format (hh:mm:ss, dd.dd), where:

• hh:mm:ss is the time for that data point in hours, minutes, and seconds.

• dd.dd is the number of bits or bytes (as set in the Preferences window) 
received per second for that data point.

To remove the data for a link from the chart, click the icon in the SLC field. 
To return the data to the chart, click the icon again.

The total time displayed in the chart is specified in the Time Window (mins) 
field.

New data points are added to the right side of the chart. When the chart 
reaches the end of the time window (for example, after 5 minutes, if the Time 
Window (mins) field is set to 5), new data points continue to be added to the 
right side of the chart, while old data points “drop off” the left side of the 
chart.

If a poll is missed (for example, as a result of an SNMP timeout), SGM 
ignores the missing data point, stops drawing the line, and waits for the next 
valid data point to begin drawing the line again.

To scroll left, right, up, or down in the chart, drag the cursor while holding 
down Ctrl and the left mouse button.

To zoom in on a section of the chart, drag the cursor while holding down Shift 
and the left mouse button.

To reset the chart to the default view and scaling, click Reset.

SLC Displays up to 16 color-coded icons, one for each link (SLC) in the Bits 
Received Chart or Bytes Received Chart.

To remove the data for a link from the chart, click the icon in this field. To 
return the data to the chart, click the icon again.

SGM enables you to customize the symbols, line styles, and colors assigned 
to data points in real-time data charts. For more information, see the Charts 
Settings, page 23-13.

Reset If you scrolled or zoomed the chart, resets the chart to the default view and 
scaling.

Field or Button Description
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BitsSentPerSec or BytesSentPerSec

SGM enables you to view real-time bits-sent-per-second information for the 
selected linkset (or bytes-sent-per-second information, if you cleared the Show 
Details in Bits Instead of Bytes checkbox in the Preferences Window). To do so, 
select the Charts tab in the Statistic Details Window for a Linkset, then select the 
BitsSentPerSec or BytesSentPerSec tab. SGM displays the BitsSentPerSec or 
BytesSentPerSec chart.

The BitsSentPerSec chart (or BytesSentPerSec chart, if you cleared the Show 
Details in Bits Instead of Bytes checkbox in the Preferences Window) contains 
the following fields and buttons:

Grid On Superimposes a graphic grid on the chart. The grid can make the data easier 
to read.

Grid Off Removes the graphic grid from the chart.

Help Displays online help for the current window.

Field or Button Description

Field or Button Description

Linkset Drop-down list box used to select the linkset for which data is to be displayed.

By default, data is displayed for the selected linkset. To display data for the 
adjacent linkset, select it in this list box.

Time Window (mins) Drop-down list box used to specify the length of time displayed in the Bits 
Sent Chart or Bytes Sent Chart.

Valid selections are 1, 2, 5, 10, 20, 40, or 60 minutes. The default selection is 
5 minutes.
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Bits Sent Chart
or
Bytes Sent Chart

Displays the Bits Sent Per Sec or Bytes Sent Per Sec for the linkset as a 
function of time, including data for up to 16 links.

To see the exact time and data coordinates for a data point, left-click the data 
point. The coordinates are displayed in the format (hh:mm:ss, dd.dd), where:

• hh:mm:ss is the time for that data point in hours, minutes, and seconds.

• dd.dd is the number of bits or bytes (as set in the Preferences window) 
sent per second for that data point.

To remove the data for a link from the chart, click the icon in the SLC field. 
To return the data to the chart, click the icon again.

The total time displayed in the chart is specified in the Time Window (mins) 
field.

New data points are added to the right side of the chart. When the chart 
reaches the end of the time window (for example, after 5 minutes, if the Time 
Window (mins) field is set to 5), new data points continue to be added to the 
right side of the chart, while old data points “drop off” the left side of the 
chart.

If a poll is missed (for example, as a result of an SNMP timeout), SGM 
ignores the missing data point, stops drawing the line, and waits for the next 
valid data point to begin drawing the line again.

To scroll left, right, up, or down in the chart, drag the cursor while holding 
down Ctrl and the left mouse button.

To zoom in on a section of the chart, drag the cursor while holding down Shift 
and the left mouse button.

To reset the chart to the default view and scaling, click Reset.

SLC Displays up to 16 color-coded icons, one for each link (SLC) in the Bits Sent 
Chart or Bytes Sent Chart.

To remove the data for a link from the chart, click the icon in this field. To 
return the data to the chart, click the icon again.

SGM enables you to customize the symbols, line styles, and colors assigned 
to data points in real-time data charts. For more information, see the Charts 
Settings, page 23-13.

Reset If you scrolled or zoomed the chart, resets the chart to the default view and 
scaling.

Field or Button Description
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Drops

SGM enables you to view drops information for the selected linkset. To do so, 
select the Charts tab in the Statistic Details Window for a Linkset, then select the 
Drops tab. SGM displays the Drops chart.

The Drops chart contains the following fields and buttons:

Grid On Superimposes a graphic grid on the chart. The grid can make the data easier 
to read.

Grid Off Removes the graphic grid from the chart.

Help Displays online help for the current window.

Field or Button Description

Field or Button Description

Linkset Drop-down list box used to select the linkset for which data is to be displayed.

By default, data is displayed for the selected linkset. To display data for the 
adjacent linkset, select it in this list box.

Time Window (mins) Drop-down list box used to specify the length of time displayed in the Drops 
Chart.

Valid selections are 1, 2, 5, 10, 20, 40, or 60 minutes. The default selection is 
5 minutes.
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Drops Chart Displays the Drops for the linkset as a function of time, including data for up 
to 16 links.

To see the exact time and data coordinates for a data point, left-click the data 
point. The coordinates are displayed in the format (hh:mm:ss, dd.dd), where:

• hh:mm:ss is the time for that data point in hours, minutes, and seconds.

• dd.dd is the number of drops for that data point.

To remove the data for a link from the chart, click the icon in the SLC field. 
To return the data to the chart, click the icon again.

The total time displayed in the chart is specified in the Time Window (mins) 
field.

New data points are added to the right side of the chart. When the chart 
reaches the end of the time window (for example, after 5 minutes, if the Time 
Window (mins) field is set to 5), new data points continue to be added to the 
right side of the chart, while old data points “drop off” the left side of the 
chart.

If a poll is missed (for example, as a result of an SNMP timeout), SGM 
ignores the missing data point, stops drawing the line, and waits for the next 
valid data point to begin drawing the line again.

To scroll left, right, up, or down in the chart, drag the cursor while holding 
down Ctrl and the left mouse button.

To zoom in on a section of the chart, drag the cursor while holding down Shift 
and the left mouse button.

To reset the chart to the default view and scaling, click Reset.

SLC Displays up to 16 color-coded icons, one for each link (SLC) in the Drops 
Chart.

To remove the data for a link from the chart, click the icon in this field. To 
return the data to the chart, click the icon again.

SGM enables you to customize the symbols, line styles, and colors assigned 
to data points in real-time data charts. For more information, see the Charts 
Settings, page 23-13.

Reset If you scrolled or zoomed the chart, resets the chart to the default view and 
scaling.

Field or Button Description
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Attaching a Note to a Linkset
SGM enables you to annotate a linkset, attaching a descriptive string to it.

To annotate a linkset, right-click a linkset in a window, then select Edit Notes in 
the right-click menu. SGM displays the Edit Notes Dialog for a Linkset.

If both ends of the linkset are known to SGM, one is displayed in the top half of 
the Edit Notes Dialog for a Linkset, the other in the bottom half. If only one end 
is known to SGM, only that end is displayed.

The Edit Notes Dialog for a Linkset contains the following fields and buttons:

Related Topics:

• Viewing Notes for a Linkset, page 8-54

Grid On Superimposes a graphic grid on the chart. The grid can make the data easier 
to read.

Grid Off Removes the graphic grid from the chart.

Help Displays online help for the current window.

Field or Button Description

Field or Button Description

Name Name of the linkset. You cannot edit this field.

Note Last Updated Date and time the Notes field for this linkset was last updated. If there is no note 
currently associated with this linkset, this field displays the value Not Set.

You cannot edit this field.

Notes Notes to associate with this linkset. In this field, you can enter any important 
information about the linkset, such as a detailed description, its location, its 
service history, and so on.

Save Saves changes you have made to the linkset’s notes and exits the dialog.

Cancel Exits the dialog without saving any changes.

Help Displays online help for the dialog.
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Viewing Notes for a Linkset
SGM enables you to view any notes that have been associated with a linkset.

To view a note for a linkset, right-click a linkset in a window, then select View > 
Notes in the right-click menu. (The Notes option is grayed-out if there is no note 
associated with the selected linkset.)

SGM displays the Notes panel for the selected linkset, which displays:

• Notes associated with the linkset.

• The date and time the notes associated with the linkset were last updated, or 
the phrase Not Set if there are no notes associated with the linkset.

• The phrase No Notes if there are no notes associated with the linkset.

Related Topics:

• Attaching a Note to a Linkset, page 8-53

Deleting a Linkset
After Discovery, the linksets in your network are known to SGM and added to the 
SGM database. Physically deleting linksets from your network is not the same as 
deleting them from the SGM database. The following sections describe the 
differences between deleting linksets from your network and from the SGM 
database, and the procedures for doing so:

• Deleting a Linkset from Your Network, page 8-54

• Deleting a Linkset from the SGM Database, page 8-55

Deleting a Linkset from Your Network
If you physically delete a known linkset from your network, it remains in the SGM 
database, SGM labels it Unknown, and it is the system administrator’s 
responsibility to delete it from the SGM database, if you choose to do so. SGM 
labels all associated nodes Warning and all associated links Unknown.
8-54
Cisco Signaling Gateway Manager User Guide

OL-7064-01



 

Chapter 8      Working with Linksets
    Deleting a Linkset
When you redefine the linkset (that is, when you define a linkset with the same 
destination point code as the original linkset, but not necessarily with the same 
linkset name), SGM rediscovers the linkset and labels it with the appropriate 
status (such as Active).

Deleting a Linkset from the SGM Database
Typically, you delete a linkset in the SGM database for one of the following 
reasons:

• You have physically deleted the linkset from your network. This is the most 
common reason for deleting a linkset from the SGM database.

• The linkset is Unknown or Unavailable, you are aware of the reason, and you 
no longer want to see it in SGM displays. For example, the linkset might be 
associated with a node that was removed from the network, or it might be a 
previously discovered linkset associated with a test lab device.

If you have physically deleted a known linkset from your network, and you then 
delete it from SGM, it is no longer in the SGM database, it does not appear in 
SGM windows, and it is not discovered when you run Discovery.

If you have not physically deleted a known linkset from your network, and you 
delete it from SGM, SGM also automatically deletes all associated links from the 
SGM database. However, at the next poll SGM finds the linkset and associated 
links and adds them back to the SGM database, setting the status appropriately. If 
this happens, do not delete the linkset again. Instead, set it to Ignored. See the 
“Ignoring a Linkset” section on page 8-56 for more information.

Note If you delete a linkset from the SGM database, the linkset is deleted for all SGM 
clients and views connected to that SGM server.

If you delete all linksets to an Unmanaged node, SGM does not automatically 
delete the node. Instead, you must manually delete the node. See the “Deleting a 
Node” section on page 6-100 for more information.
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To delete a linkset from the SGM database, use one of the following procedures:

• Select one or more linksets in a window, then select Edit > Delete from the 
SGM Main Menu.

• Right-click a linkset in a window, then select Delete in the right-click menu. 
(You cannot delete more than one linkset at a time from the right-click menu.)

SGM asks you to confirm the deletion:

• Select Yes to delete the selected linksets. SGM deletes the linksets and all 
associated links from the SGM database. However, if the linksets were not 
physically deleted from your network, then at the next poll SGM finds the 
linksets and their associated links and adds them back to the SGM database, 
setting the status appropriately.

• Select No to return to the window without deleting any linksets or links from 
the SGM database.

You can also use the sgm delete linkset command to delete one or more linksets 
from the SGM database. See the “sgm delete” section on page C-24 for more 
information on the use of this command.

Ignoring a Linkset
You can instruct SGM to ignore a linkset when it aggregates and displays network 
data. Setting linksets to Ignored prevents known linkset problems from affecting 
SGM displays for associated objects. In effect, you are preventing a known 
problem from distracting you from other, more urgent network problems.

For example, you can set a linkset to Ignored before shutting down the linkset for 
maintenance.

Note If you set a linkset to Ignored, the linkset is ignored for all SGM clients and views 
connected to that SGM server.

Also, if you set a linkset to Ignored, make a note of the change, and do not forget 
to reset the linkset when the problem is corrected or the maintenance is complete.
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To set a linkset to Ignored in the Linkset Window, select the Ignored checkbox 
for the linkset you want SGM to ignore.

To set a linkset to Ignored in the Topology Window, select a linkset in the 
topology map, then, in the left pane, select the Ignored checkbox for the linkset 
you want SGM to ignore.

Viewing Ignored Linksets
To display all linksets that are Ignored, display the Linkset Window and click the 
Ignored column header. SGM displays all ignored linksets at the top of the table.

Viewing Linkset Information Using a Web Browser
SGM enables you to use a Web browser to view the following information about 
linksets:

• Viewing the Network Status Linkset Dashboard, page 8-57

• Viewing ITP Linkset Status, page 8-59

• Viewing ITP Linkset Details, page 8-62

• Viewing ITP Linkset Information: Access Lists, page 8-72

Viewing the Network Status Linkset Dashboard
The SGM Linkset Dashboard page lists all discovered linksets, and provides links 
to messages and metrics for each linkset.

To access the SGM Linkset Dashboard page, select Network Status Dashboard 
from the SGM Server Home Page, then click Linkset Dashboard.
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The Linkset Dashboard table contains the following columns:

Column Description

Server Name
(in header)

Name of the SGM server associated with the linkset.

Update Interval
(in header)

Time between automatic updates for the page. None means the page is not 
automatically updated.

Last Update
(in header)

Date and time the information on the page was last updated by SGM.

Linksets Linksets discovered by SGM.

You can sort the table based on the information in the Linksets column. See 
the “Resizing, Sorting, and Hiding Table Columns” section on page 3-53 for 
more details.

Drill-Down Links: 
Messages

Opens the Network Status: Last X Status Change and Trap Messages Web page 
for the linkset.

Drill-Down Links: 
Metrics

Opens the Network Status Messages: Metrics Web page for the linkset.

Drill-Down Links: 
Access Lists

Opens the SGM ITP Access Lists Web page for the linkset.

This option is not available if the linkset is in Unknown or Unavailable status, 
or if the linkset is a Virtual linkset.

Latest Reports: 
Linkset Statistics

Displays the most recent Linkset Statistics: Hourly Report for the linkset, in a 
Web browser.

Latest Reports: 
Linkset Peaks

Displays the most recent Linkset Utilization Peaks - Rolling 30 Days Report 
for the linkset, in a Web browser.

Latest Reports: 
Link Statistics

Displays the most recent Link Statistics: Hourly Report for the links associated 
with the linkset, in a Web browser.

Latest Reports: 
Link Peaks

Displays the most recent Link Utilization Peaks - Rolling 30 Days Report for 
the links associated with the linkset, in a Web browser.

Displaying Results Shows the total number of results found, and allows you to page through the 
results. To configure the page range counts, see the “Changing SGM Web 
Preferences” section on page 17-12.
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Viewing ITP Linkset Status
The SGM ITP Linkset Status page displays information about the linksets that 
have been discovered by SGM.

To access the SGM ITP Linkset Status page, select ITP Linkset Status from the 
SGM Server Home Page. SGM displays the SGM ITP Linkset Status page.

You can sort the SGM ITP Linkset Status table based on the information in one of 
the columns. See the “Resizing, Sorting, and Hiding Table Columns” section on 
page 3-53 for more details.

The SGM ITP Linkset Status page displays the following information for each 
linkset:

Column Description

Server Name
(in header)

Name of the SGM server associated with the linkset.

Update Interval
(in header)

Time between automatic updates for the page.

Last Update
(in header)

Date and time the information on the page was last updated by SGM.

Linkset Name Name of the linkset.

To see detailed information for the linkset, click the linkset name.

Node Name of the node associated with the linkset.

To see detailed information for the node, click the node name.

SP Name Name of the signaling point associated with the linkset.

To see detailed information for the signaling point, click the signaling point 
name.

Point Code Point code of the primary signaling point for the linkset.

Adjacent Linkset 
Name

Name of adjacent linkset.

To see detailed information for the linkset, click the linkset name.

Adjacent Node Name of adjacent node for the linkset.

To see detailed information for the node, click the node name.
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Adjacent SP Name of adjacent signaling point for the linkset.

To see detailed information for the signaling point, click the signaling point 
name.

Adjacent Point 
Code

Point code of the adjacent signaling point for the linkset.

Status Current status of the linkset, with a color-coded background. Possible values are:

Active (green)

Shutdown (blue)

Unavailable (red)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see the “Status Definitions for Linksets” 
section on page A-5.

Column Description
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Status Reason Reason for the current status of the signaling gateway mated pair.

For a full list of possible reasons, see the stateReasons.html file:

• If you installed SGM in the default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• If you installed SGM in a different directory, then the help directory and file 
are located in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full status reason in a mouse over help popup.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude is displayed.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the sgm cleandiscover command to delete all current network data and 
begin a clean discovery of the ITP network. If the status reason is still 
Unsupported Configuration, enter the sgm clean command to restore the SGM 
server to a “clean” state, such as would exist after a new installation of SGM. For 
more information on the use of these commands, see the “SGM Command 
Reference” section on page C-1.

Column Description
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Viewing ITP Linkset Details
The SGM Linkset Details page displays detailed information about all discovered 
linksets, including their associated signaling points, links, events, status, and 
other information.

To access the SGM Linkset Details page, click a linkset name in the SGM ITP 
Linkset Status page. SGM displays the SGM Linkset Details page.

The SGM Linkset Details page is composed of the following sections:

• SGM Linkset Details Table, page 8-63

• SGM Links Detail Table, page 8-70

Related Topic

• Viewing ITP Linkset Details, page 8-62

Type Type of linkset, which SGM determines by examining the links defined in the 
linkset. Possible linkset types are:

• HSL—The links in this linkset use the SS7-over-ATM (Asynchronous 
Transfer Mode) high-speed protocol.

• SCTPIP—The links in this linkset use the Stream Control Transmission 
Protocol (SCTP) IP transport protocol.

• Serial—The links in this linkset use the serial SS7 signaling protocol.

• Mixed—The links in this linkset are of two or more types. (This 
configuration is not recommended.)

• Virtual—The links in this linkset are virtual links, which connect signaling 
point instances running on the same device. SGM does not poll virtual 
linksets, nor does it display real-time data or accounting statistics for virtual 
linksets.

Note Prior to IOS release 12.2(23)SW1, virtual linksets on multi-instance 
routers were created manually by the user. Within and after that release, 
virtual linksets are created automatically.

• Other—No links have been defined for this linkset.

Column Description
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SGM Linkset Details Table

The SGM Linkset Details table displays the following information for the selected 
linkset:

Field Description

Node Name, Signaling 
Point Name, and Linkset 
Name
(in header)

DNS name of the node, as discovered by SGM, signaling point name, 
and linkset name.

Server Name
(in header)

Name of the SGM server associated with the linkset.

Update Interval
(in header)

Time between automatic updates for the page.

Last Update
(in header)

Date and time the information on the page was last updated by SGM.

Node Name of primary node for the linkset. To see detailed information for the 
node, click the node name.

Signaling Point Name of primary signaling point for the linkset. To see detailed 
information for the signaling point, click the signaling point name.

Linkset Name Name of the linkset.

Drill-Down Links: 
Messages

Opens the Network Status: Last X Status Change and Trap Messages 
Web page for the linkset.

Drill-Down Links: Metrics Opens the Network Status Messages: Metrics Web page for the linkset.

Drill-Down Links: Access 
Lists

Opens the SGM ITP Access Lists Web page for the linkset.

This option is not available if the linkset is in Unknown or Unavailable 
status, or if the linkset is a Virtual linkset.

Latest Reports: Linkset 
Statistics

Displays the most recent Linkset Statistics: Hourly Report for the 
linkset, in a Web browser.

Latest Reports: Linkset 
Peaks

Displays the most recent Linkset Utilization Peaks - Rolling 30 Days 
Report for the linkset, in a Web browser.

Latest Reports: Link 
Statistics

Displays the most recent Link Statistics: Hourly Report for the links 
associated with the linkset, in a Web browser.
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Latest Reports: Link 
Peaks

Displays the most recent Link Utilization Peaks - Rolling 30 Days 
Report for the links associated with the linkset, in a Web browser.

Status Current status of the linkset, with a color-coded background. Possible 
values are:

Active (green)

Shutdown (blue)

Unavailable (red)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see the “Status Definitions for 
Linksets” section on page A-5.

Status Reason Reason for the current status of the signaling gateway mated pair.

For a full list of possible reasons, see the stateReasons.html file:

• If you installed SGM in the default directory, /opt, then the file is 
located at /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• If you installed SGM in a different directory, then the help directory 
and file are located in that directory.

If the cell is too small to show all of the status reason, place the cursor 
over the cell to see the full status reason in a mouse over help popup.

The status reasons are listed in order of decreasing magnitude. If two or 
more reasons apply, the reason of greatest magnitude is displayed.

If the status reason is Unsupported Configuration, correct the 
configuration and enter the sgm cleandiscover command to delete all 
current network data and begin a clean discovery of the ITP network. If 
the status reason is still Unsupported Configuration, enter the sgm 
clean command to restore the SGM server to a “clean” state, such as 
would exist after a new installation of SGM. For more information on 
the use of these commands, see the “SGM Command Reference” section 
on page C-1.

Description Description of the linkset. If the linkset has no description, this field is 
blank.

Field Description
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Poll Error Message Last error message received by the linkset. If there have been no polling 
errors, this field is not displayed.

Local Point Code Point code of the primary signaling point for the linkset.

Adjacent Node Name of adjacent node for the linkset. To see detailed information for 
the adjacent node, click the node name.

Adjacent Signaling Point Name of adjacent signaling point for the linkset. To see detailed 
information for the adjacent signaling point, click the signaling point 
name.

Adjacent Point Code Point code of the adjacent signaling point for the linkset.

Linkset Type Type of linkset, which SGM determines by examining the links defined 
in the linkset. Possible linkset types are:

• HSL—The links in this linkset use the SS7-over-ATM 
(Asynchronous Transfer Mode) high-speed protocol.

• SCTPIP—The links in this linkset use the Stream Control 
Transmission Protocol (SCTP) IP transport protocol.

• Serial—The links in this linkset use the serial SS7 signaling 
protocol.

• Mixed—The links in this linkset are of two or more types. (This 
configuration is not recommended.)

• Virtual—The links in this linkset are virtual links, which connect 
signaling point instances running on the same device. SGM does not 
poll virtual linksets, nor does it display real-time data or accounting 
statistics for virtual linksets.

Note Prior to IOS release 12.2(23)SW1, virtual linksets on 
multi-instance routers were created manually by the user. Within 
and after that release, virtual linksets are created automatically.

• Other—No links have been defined for this linkset.

Links Total number of links in the linkset.

Active Links Number of links in the linkset that are Active.

Congested Links Number of links in the linkset that are Congested.

Note Note associated with this linkset. If there is no note associated with this 
linkset, this field is blank.

Field Description
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Note Timestamp Date and time the note associated with this linkset was last updated. If 
there is no note associated with this linkset, this field is blank.

Internal ID Internal ID of the linkset. The internal ID is a unique ID for every object, 
assigned by SGM for its own internal use. It can also be useful when the 
Cisco TAC is debugging problems.

MTP3 Accounting 
Enabled

Indicates whether the collection of MTP3 accounting statistics is 
enabled for the linkset.

If the linkset is a Virtual linkset, this field displays N/A.

GTT Accounting Enabled Indicates whether the collection of GTT accounting statistics is enabled 
for the linkset.

For Cisco IOS software releases prior to 12.2(4)MB10, this field 
displays Unknown.

If the linkset is a Virtual linkset, this field displays N/A.

Packets Received Per Sec. Number of packets received by the linkset per second.

This field initially displays the phrase Waiting for second poll. After 
two polling cycles, SGM populates this field with actual calculated 
rates.

Packets Sent Per Sec. Number of packets sent by the linkset per second.

This field initially displays the phrase Waiting for second poll. After 
two polling cycles, SGM populates this field with actual calculated 
rates.

Bits Received Per Sec. Number of bits received by the linkset per second.

This field initially displays the phrase Waiting for second poll. After 
two polling cycles, SGM populates this field with actual calculated 
rates.

Bits Sent Per Sec. Number of bits sent by the linkset per second.

This field initially displays the phrase Waiting for second poll. After 
two polling cycles, SGM populates this field with actual calculated 
rates.

Field Description
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Receive Utilization Amount of the linkset’s receive capacity being used, as a percentage or 
in Erlangs (as set in the Preferences window), calculated using the 
following formula:

Receive Utilization = (Bits Received Per Sec.)/Planned Capacity

Planned Capacity is the planned capacity of the linkset in bits per 
second.

• For a linkset of type Serial, Planned Capacity is the available 
bandwidth for the linkset.

• For a linkset of type SCTPIP or of type Mixed, Planned Capacity 
is set on the ITP using the plan-capacity CS7 linkset configuration 
command.

If Planned Capacity is not set on the ITP for one or more of the 
links associated with this linkset, this field displays the phrase 
Planned Capacity for ITP Not Set.

• For a linkset of type Other, this field displays the phrase Planned 
Capacity for ITP Not Set.

This field initially displays the phrase Waiting for second poll. After 
two polling cycles, SGM populates this field with actual calculated 
rates.

If the planned receive capacity is not set for the SCTP link, this field 
displays Set Plan Capacity on ITP.

Field Description
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Send Utilization Amount of the linkset’s send capacity being used, as a percentage or in 
Erlangs (as set in the Preferences window), calculated using the 
following formula:

Send Utilization = (Bits Sent Per Sec.)/Planned Capacity

Planned Capacity is the planned capacity of the linkset in bits per 
second.

• For a linkset of type Serial, Planned Capacity is the available 
bandwidth for the linkset.

• For a linkset of type SCTPIP or of type Mixed, Planned Capacity 
is set on the ITP using the plan-capacity CS7 linkset configuration 
command.

If Planned Capacity is not set on the ITP for one or more of the 
links associated with this linkset, this field displays the phrase 
Planned Capacity for ITP Not Set.

• For a linkset of type Other, this field displays the phrase Planned 
Capacity for ITP Not Set.

This field initially displays the phrase Waiting for second poll. After 
two polling cycles, SGM populates this field with actual calculated 
rates.

If the planned send capacity is not set for the SCTP link, this field 
displays Set Plan Capacity on ITP.

Receive Plan Capacity Planned capacity of the linkset to receive, in bits per second.

• For a linkset of type Serial or HSL, available bandwidth for the 
linkset.

• For a linkset of type SCTPIP or Mixed, set on the ITP using the 
plan-capacity CS7 linkset configuration command.

If Receive Plan Capacity is not set on the ITP for one or more of 
the links associated with this linkset, this field displays the value 0.

• For a linkset of type Other, this field always displays the value 0.

Field Description
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Send Plan Capacity Planned capacity of the linkset to send, in bits per second.

• For a linkset of type Serial or HSL, available bandwidth for the 
linkset.

• For a linkset of type SCTPIP or Mixed, set on the ITP using the 
plan-capacity CS7 linkset configuration command.

If Send Plan Capacity is not set on the ITP for one or more of the 
links associated with this linkset, this field displays the value 0.

• For a linkset of type Other, this field always displays the value 0.

Drops Total number of packets that have been dropped by the linkset.

Inbound ACL Inbound IP access control list (ACL) number for the linkset.

If there is no inbound ACL for the linkset, this field displays 0.

If the linkset is a Virtual linkset, this field displays N/A.

Outbound ACL Outbound ACL number for the linkset.

If there is no outbound ACL for the linkset, this field displays 0.

If the linkset is a Virtual linkset, this field displays N/A.

Duration In Service % Percentage of time the linkset has been in service since the last reboot 
of the ITP, or since ITP last reset the counters.

Duration Out Of 
Service %

Percentage of time the linkset has been out of service since the last 
reboot of the ITP, or since ITP last reset the counters.

Field Description
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SGM Links Detail Table

The SGM Links Detail table displays the following information about links 
associated with the selected linkset:

Column Description

SLC Signaling link code (SLC) ID for the link.

Type Type of link. Possible link types are:

• HSL—The link uses the SS7-over-ATM (Asynchronous Transfer Mode) 
high-speed protocol.

• SCTPIP—The link uses the Stream Control Transmission Protocol (SCTP) 
IP transport protocol.

• Serial—The link uses the serial SS7 signaling protocol.

• Virtual—The link is a virtual link, which connects signaling point instances 
running on the same device. SGM does not poll virtual links, nor does it 
display real-time data or accounting statistics for virtual links.

Interface Name Primary IP address and interface name of the link. The primary IP address is the 
first CS7 local IP address configured in the ITP. For example, if the following IP 
addresses are configured in the ITP:

cs7 local-peer 4180
local-ip 128.3.0.77
local-ip 128.3.0.254

Then SGM uses 128.3.0.77 as the primary IP address. If at any time that IP 
address is deleted from the ITP configuration, or if a new IP address is added to 
the beginning of the list, SGM detects the change and automatically updates this 
field to reflect the new primary IP address.

If the link has no interface name, this field is blank.

Ports Local and remote ports for the link.

QoS Quality of service (QoS) class of the link.
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Congestion Indicates whether there is congestion on the link. A link is congested if it has too 
many packets waiting to be sent. This condition could be caused by the failure 
of an element in your network.

Possible values for the Congestion Level field are None, indicating no 
congestion, and 1 to 7, indicating levels of congestion from very light (1) to very 
heavy (7).

Utilization Receive Utilization (Rcvd) and Send Utilization (Sent) for the link, expressed as 
either a utilization percentage or a number of Erlangs.

This field initially displays the phrase Waiting for second poll. After two 
polling cycles, SGM populates this field with actual calculated rates.

If the planned send or receive capacity is not set for the SCTP link, this field 
displays Set Plan Capacity on ITP.

Bits/Sec Number of bits received (Rcvd) and sent by the link per second.

This field initially displays the phrase Waiting for second poll. After two 
polling cycles, SGM populates this field with actual calculated rates.

Ignored Indicates whether the link has been flagged as Ignored (that is, whether the link 
is to be included when aggregating and displaying SGM status information).

Status Current status of the link, with a color-coded background. Possible values are:

Active (green)

Blocked (red)

Failed (red)

InhibitLoc (blue)

InhibitRem (blue)

Shutdown (blue)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see the “Status Definitions for Links” 
section on page A-4.

There is no Unshut or No Shut status.

Column Description
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Viewing ITP Linkset Information: Access Lists
The SGM ITP Access Lists page displays all access lists associated with the 
selected linkset.

To access the SGM ITP Access Lists page for a linkset:

From the SGM Linkset Details page, select Access List from the Drill-Down 
Links drop-down menu and click Go! (this option is not available if the associated 
signaling point is in Unknown or Unmanaged status, or if the linkset is a Virtual 
linkset.)

Status Reason Reason for the current status of the signaling gateway mated pair.

For a full list of possible reasons, see the stateReasons.html file:

• If you installed SGM in the default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• If you installed SGM in a different directory, then the help directory and file 
are located in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full status reason in a mouse over help popup.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude is displayed.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the sgm cleandiscover command to delete all current network data and 
begin a clean discovery of the ITP network. If the status reason is still 
Unsupported Configuration, enter the sgm clean command to restore the SGM 
server to a “clean” state, such as would exist after a new installation of SGM. For 
more information on the use of these commands, see the “SGM Command 
Reference” section on page C-1.

Status Summary Opens the SGM Link Status Summary Web Page.

Column Description
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The SGM ITP Access Lists table displays the following information for the 
selected linkset:

Column Description

Node Name, 
Signaling Point 
Name, and Linkset 
Name
(in header)

Name of the node, signaling point, and linkset for which access lists are being 
displayed.

Server Name
(in header)

Name of the SGM server associated with the signaling point or linkset.

Update Interval
(in header)

Time between automatic updates for the page.

Last Update
(in header)

Date and time the information on the page was last updated by SGM.

Node/SP/Linkset Name of the node, signaling point, and linkset for which access lists are being 
displayed.

To see detailed information for the node, signaling point, or linkset, click the 
node, signaling point, or linkset name.

List # Access list number configured on the node and applied to the linkset. ITP uses 
access list numbers 2700 through 2799.

Access List List of commands in the access list.
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